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ZONA DA MATA MINEIRA ENTRE 1996-2004 

 

 

RESUMO 

Este trabalho buscou examinar se existe alguma correlação direta entre a supressão de mata 

nativa com a redução do pessoal empregado por estabelecimento agropecuário. A análise foi 

feita a nível municipal na Microrregião de Ubá em Minas Gerais. A busca por essa relação 

surgiu na leitura de um trabalho publicado em 2004 por Fernanda Cabral Santos, onde a 

autora atribui à pecuária os processos de desmatamento na Mata Atlântica, relatando que a 

pecuária caracteriza-se também por ser pouco intensiva em mão de obra. Logo a conversão de 

mata nativa em pastagem demandaria baixo emprego de mão-de-obra no campo. O 

procedimento metodológico consistiu na coleta de áreas desmatadas via análise por 

Sensoriamento Remoto por intermédio de imagens orbitais do satélite Landsat 5 com o 

trabalho realizado em uma escala de 1:60.000, a microrregião de Ubá representante da área de 

estudo é composta por 17 municípios distribuídos em 3.593,648 km². O período analisado na 

coleta dos focos de desmate foi de 1996 até o ano de 2004. Obtendo, portanto uma área 

desmatada de 255 hectares. Os dados referentes ao número de pessoas empregadas por 

estabelecimento agropecuário foram providos pelo Instituto Brasileiro de Geografia e 

Estatística (IBGE) mais especificamente os dados levantados no Censo Agropecuário de 1996 

e 2006. Com o objetivo de verificar a relação optou-se por utilizar o procedimento estatístico 

de regressão linear simples, os dados mostraram que não existe, entretanto relação alguma 

entre o desmatamento e a redução do pessoal empregado por estabelecimento agropecuário na 

microrregião de Ubá entre 1996 - 2004.  

 

Palavras-chave: Sensoriamento Remoto, Desmatamento, SIG, Microrregião de Ubá, Êxodo 

Rural.
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  Introdução 

Os produtores rurais, em busca de maximizar os ganhos advindos do trabalho na terra, 

têm tomado medidas severas contra a biodiversidade, instituindo a supressão de mata nativa 

como uma das alternativas ao incremento de renda, como justificativa, alegando que a 

expansão de área produtiva se torna indispensável para um ganho mais expressivo.  

A gênese que motivou o tema do presente trabalho foi minha experiência como 

bolsista da SEMAD/IEF no escritório do Centro de Estudos e Desenvolvimentos Florestais 

(CEDEF), mais especificamente quando da atuação no projeto “Monitoramento Continuo da 

Cobertura Vegetacional em Minas Gerais”. Projeto que tratava da coleta mensal dos 

polígonos georeferenciados de desmate ocorrido em todo território de Minas Gerais, com 

intuito de auxiliar as equipes fiscalizadoras em campo. 

O expressivo número dos desmatamentos observados durante a execução do projeto, 

os quais recobriam extensas áreas do bioma mata atlântica, chamou a atenção para o fato, pois 

mesmo assegurado por leis específicas que impedem a supressão de áreas nativas em região 

de domínio do bioma, como a popularmente chamada Lei da Mata Atlântica, lei nº 11.428, de 

22 de dezembro de 2006, a qual dispõe sobre a utilização e proteção da vegetação nativa do 

Bioma Mata Atlântica. O avanço da fronteira agrícola ainda encontra-se marcante no estado 

de Minas Gerais neste bioma.   

Teria o produtor rural realmente a necessidade de desmatar para maximizar sua 

produção e ganho efetivo? Até que ponto o corte de floresta pode influenciar positivamente 

nos indicadores sociais do campo?  

Santos (2004) já discutia a ação do desmatamento e seus efeitos perante a sociedade 

do ponto de vista ambiental e seu reflexo financeiro para o setor produtivo rural. Neste 

sentido, o trabalho buscou entender se existe relação entre o numero de trabalhadores rurais 

ocupados por estabelecimentos agropecuários com o processo de supressão de mata nativa nas 

propriedades rurais, ocorridos na microrregião de Ubá da Zona da Mata de Minas Gerais no 

período de 1996 a 2004. 

Uma análise mais aprofundada de alguns indicadores do Censo Agropecuário de 1996 

e do censo agropecuário de 2006, devidamente confrontados com os dados de desmatamento 

que foram obtidos pela pesquisa por intermédio do uso do NDVI aplicado as imagens do 
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sensor TM do satélite Landsat 5 com as operações realizadas em uma escala de trabalho de 

1:60.000, serviu de apoio no entendimento dessa questão. 

A comparação estatística em regressão linear simples dessas informações para cada 

município da microrregião de Ubá trará significativas conclusões sobre a realidade do numero 

de trabalhadores rurais empregados em estabelecimentos agropecuários antes da expansão de 

área produtiva por desmatamento, e seu reflexo posterior. 

O estudo se limita a tratar da questão que envolve o numero de trabalhadores 

empregados no campo, independente da população residente em zona rural ou sua migração 

para as cidades, o que foi colocado em voga é a capacidade que o desmatamento teria dentro 

das propriedades rurais de alterar o numero de funcionários por estabelecimento agropecuário, 

se esse desmatamento seria capas de reduzir ou aumentar esse numero de trabalhadores em 

níveis homogêneos para cada município da região de estudo.  

Levanto a hipótese para esse trabalho: o desmatamento não está diretamente 

relacionado ao aumento do numero de trabalhadores rurais empregados por estabelecimento 

no campo, pelo contrário possivelmente vamos detectar uma redução proporcional ao 

aumento do desmate uma vez que já existem estudos que comprovam que a maior conversão 

dá floresta se da para implantação de modelos extensivos de produção agropecuária de baixa 

demanda de mão de obra.   
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2 Objetivos 

2.1 Objetivo geral 

Verificar a existência de correlação entre a alteração do numero de trabalhadores 

rurais empregados por estabelecimento agropecuário, com a supressão de floresta nativa, 

realizada em propriedades rurais da microrregião de Ubá. 

Obtendo, portanto via modelo estatístico a possível existência de uma relação de efeito 

e consequência entre os indicadores sociais no campo com o volume de área desmatada. 

2.2 Objetivo especifico 

 Detectar por meio de imagens orbitais do satélite Landsat 5 sensor TM em uma 

escala de 1:60.000 toda alteração de mata nativa ocorrida no período de 1996 a 

2004 no território da microrregião de Ubá na Zona da Mata de Minas Gerais. 

 

 Correlacionar estatisticamente as informações de áreas total desmatadas por 

município da microrregião de Ubá de 1996 a 2004 com a diferença entre 

pessoal ocupado no campo por estabelecimento agropecuário entre 1996 e 

2006 conforme dados apurados no censo agropecuário do Instituto Brasileiro 

de Geografia e Estatística (IBGE 1996; 2006) 
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3 Referencial Teórico 

3.1 O desmatamento e o IDHM 

 Até que ponto o desmatamento se mostra como peça irrefutável para a melhoria da 

produção agrícola, visto que certos produtores negligenciavam até mesmo as leis para, 

garantirem maior porção de terras agricultáveis? Existiria um vínculo direto entre porções de 

terras aptas à implementação agrícola com um ganho efetivo de renda e qualidade de vida no 

campo?  

 Um estudo que trata do tema do desmatamento na Mata Atlântica e a relação com a 

condição social no campo, intitulado “Desenvolvimento Econômico, Pobreza E 

Desmatamento No Brasil: Evidências Empíricas Para As Regiões Sul E Sudeste Nas Décadas 

De 80 E 90” foi publicado em 2004 pela autora Fernanda Cabral Santos, texto construído em 

meio aos calorosos debates de reformulação do código florestal.  

A autora se mostra inconformada com os argumentos apresentados pela bancada 

ruralista nos debates ocorridos durante a formulação do projeto de lei, que viria a se tornar a 

Lei nº 12.651 de 25 de maio de 2012. Lei que estabelece normas gerais sobre a proteção da 

vegetação, áreas de Preservação Permanente e as áreas de Reserva Legal; a exploração 

florestal, o suprimento de matéria-prima florestal, o controle da origem dos produtos florestais 

e o controle e prevenção dos incêndios florestais, e prevê instrumentos econômicos e 

financeiros para o alcance de seus objetivos.  

Com o interesse restrito de expandir e legitimar seus anseios dentro da nova lei, 

segundo a autora, a bancada do congresso nacional responsável por representar os 

latifundiários do agronegócio, levanta hipóteses não respaldadas por métodos científicos.  

Para Fernanda Santos (2004) o principal argumento defendido pela Bancada Ruralista 

do Congresso Nacional, é o de que o desmatamento gera, em contrapartida, melhores 

condições de vida para as populações que se beneficiam deste processo. 

 Segundo ela os argumentos dos ruralistas não eram embasados em fundamentos 

científicos que ratificassem de forma concreta os seus anseios, possivelmente a motivação dos 

congressistas era meramente politica e econômica. 
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 Inquieta com a insustentabilidade científica desse argumento, Fernanda propõe em sua 

publicação discutir até que ponto a conversão recente de áreas de florestas no Bioma Mata 

Atlântica tem resultado em melhores condições de vida para as populações rurais.   

 Já prevendo os rumos de sua pesquisa, a autora ainda lança a hipótese que defende ao 

longo de seu trabalho de que o processo de desmatamento não está relacionado à promoção de 

melhores condições de vida à população rural. 

 O foco principal do trabalho é o bioma Mata Atlântica. Essa escolha é justificada no 

capítulo primeiro, principalmente, pela redução significativa da área original ocupada pelo 

bioma, segundo o estudo, apenas 7,3% da área original do bioma ainda subsiste. 

 São 46% dos municípios brasileiros totalmente inseridos no Domínio Mata Atlântica, 

o que resulta em 70% da população nacional vivendo no entorno desse. Certamente existe 

forte impacto social inerente dessa relação. Dai o motivo de lhe ser atribuído o título de 

segundo lugar entre as áreas mais ameaçadas dos 25 principais hotspots mundiais. (SANTOS 

2004) 

 O texto parte da análise mais global, direciona o estudo efetivamente a seis estados 

brasileiros que tem como parte da sua formação vegetal o Bioma Mata Atlântica que são eles: 

Rio Grande do Sul, Santa Catarina, Paraná, São Paulo, Rio de Janeiro e Espírito Santo. São 

feitos dois exercícios na execução, em um deles a área de estudo é ainda mais direcionada, 

são considerados apenas os 10 primeiros municípios líderes em desmatamento no período de 

1985 a 1990, de cada um dos seis estados citados.  

 A fim de validar suas ideias, são elaborados dois procedimentos teóricos um que 

considera os 10 principais líderes de desmatamento em cada um dos seis estados de 

abrangência do projeto, é então elaborado esse levantamento através de dados secundários do:  

“Atlas da Evolução dos Remanescentes Florestais e Ecossistemas Associados no 

Domínio da Mata Atlântica (elaborado pela Fundação SOS Mata Atlântica), para 

os períodos 1985-90 e 1990-95, e do Atlas de Desenvolvimento Humano no Brasil 

(elaborado pelo IPEA, PNUD e Fundação João Pinheiro), para os anos de 1991 

e 2000.” (SANTOS 2004) 

 De posse das informações do desmatamento acumulado nesse período, e 

discriminados os 10 municípios líderes em desmatamento de cada estado, a autora cruza essa 

informação com o IDHM (Índice de Desenvolvimento Humano Municipal) O IDHM é 
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acompanhado por mais de 180 indicadores socioeconômicos, que dão suporte à análise do 

IDHM e ampliam a compreensão dos fenômenos e dinâmicas voltados ao desenvolvimento 

municipal. 

 São comparadas as posições relativas de cada um desses municípios nos dois extremos 

da série histórica de aproximadamente 10 anos, para os anos de 1991 e 2000 (dados referentes 

ao IDHM).  

 A outra análise empregada, mais apurada e embasada, faz uso de estatística com um 

modelo linear, e são considerados todos os municípios dos seis estados. Santos (2004) 

defende o emprego dessa segunda técnica para evitar um possível contra-argumento ao seu 

trabalho, visto que os dados considerando apenas os 10 municípios líderes em desmate, 

poderia gerar um resultado distinto do resultado geral, por tratar apenas dos extremos críticos.      

“O primeiro exercício, baseado na performance dos dez municípios que 

mais desmataram em cada um dos estados, no período 1985-95, revela que a 

maior parte deles caracteriza-se por apresentar uma piora ou constância, em 

termos relativos, de seus níveis de desenvolvimento. Dessa forma, não se pode 

dizer que, nos municípios de maior desmatamento, este processo gerou melhores 

condições de vida à população rural. O argumento da Bancada Ruralista não se 

verificou empiricamente ao se tomar por referência os municípios que mais 

desmataram.” (SANTOS, 2004) 

 

Nesse primeiro processo de análise, a autora consegue ratificar sua hipótese inicial, 

porém ainda sem o aprofundamento mais abrangente da totalidade dos municípios, uma 

regressão estatística com formulação de linha de tendência pode subsidiar a argumentação 

dando mais embasamento ao exercício, logo o segundo método é aplicado. 

Esse agora englobando todos os municípios analisados, obtém-se resultado semelhante 

a primeira análise, portanto uma ausência de relação entre os desmatamentos ocorridos no 

período de 1990 – 1995 em comparação com o período 1985 – 1990 e a melhora dos índices 

de Desenvolvimento Humano obtidos pelos municípios em 2000. 

 Dentro da metodologia apresentada, o problema proposto por Santos, foi solucionado 

e sua hipótese inicial de que o processo de desmatamento não está relacionado à promoção de 

melhores condições de vida à população rural, mostrou-se verdadeira. 



15 
 

 Em alguns casos, num contrassenso à tese defendida pela bancada ruralista, o estudo 

provou que mais da metade dos municípios estudados se encontram entre os 50% dos de 

menor classificação de IDHM. 

 Diante dessas especificidades, Santos (2004) deixa em aberto uma questão, de que 

talvez esses municípios provavelmente tenham buscado no desmate uma saída à situação 

adversa. Mas como o trabalho analisa apenas de forma macro e em uma escala inviável para 

solucionar essa questão, Santos (2004) se limita a contrapor essa hipótese, fazendo uma 

relação inversa com os dados obtidos, os quais podem provar que o aumento de desmate não 

foi condição fundamental para uma melhoria do IDHM. 

 Logo, ainda que os produtores acreditem que a conversão de mata nativa em área 

produtiva ou até mesmo carvão, reverteria o quadro negativo, isso não se mostrou verdadeiro, 

pode em princípio trazer melhorias pontuais, mas a comunidade não goza desses benefícios de 

forma geral. 

 O texto se apresenta muito bem consolidado, com dados secundários, porém, os únicos 

dados construídos efetivamente pelo trabalho são combinações estatísticas de dados 

secundários, caberia um aprofundamento, na geração de dados para consolidar a 

argumentação. 

 Um dos temas principais do trabalho, a questão do desmatamento, não é discutida com 

muita seriedade, não é mensurado em área ou de qualquer outra forma se não o ranking dos 

principais desmatadores, com isso, o leitor fica carente de ter dados absolutos para que possa 

deduzir outras análises.  

 Durante o trabalho existem situações em que a própria autora considera insuficientes 

para conclusões sólidas como o método utilizado de teste econométrico em que relata: “É 

importante destacar que se reconhece que este modelo é um tanto simplista e que um 

tratamento mais apurado dos dados tornaria o trabalho mais preciso.”.  
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3.2 Benefícios da floresta nativa 

 A já difundida premissa de que a permanência e conservação de ecossistemas naturais 

pode gerar melhoria da qualidade de vida aos seres vivos, além de facilmente perceptível, 

parece não ser argumento suficientemente convincente a todos os produtores rurais. Dado o 

avanço persistente da derrubada de mata. Seguinte, uma breve coletânea retificando os 

benefícios indiretos da floresta no que tange à produção agrícola e permanência de qualidade 

produtiva no campo. 

 A teoria provida do senso comum de que a Amazônia seria o pulmão do mundo, 

devido a sua densa constituição vegetal de porte arbóreo pungente, não se aplica no que diz 

respeito a produção de oxigênio, visto que em porção de área os oceanos fazem conversão 

muito mais expressiva de CO2 a Oxigênio. Segundo Carpanezzi (2000), as florestas naturais 

maduras não são eficientes na retirada de CO2 da atmosfera, pois o crescimento em biomassa 

tende a zero, mas a importância da floresta madura na manutenção de um efeito estufa sadio, 

evitando disponibilidade excessiva do gás CO2 na atmosfera, é justamente pelo estoque de 

carbono neutralizado em sua biomassa. Portanto a sua substituição dessas florestas por outra 

formação de biomassa menor pode agravar a disponibilidade de carbono na atmosfera. 

 Função importante das matas dentro de áreas produtivas inclusive em áreas de 

agropecuária é quanto a sua ação como quebra-vento. Também segundo Carpanezzi (2000), o 

aumento da umidade do ar a sotavento e principalmente a redução da velocidade do vento, 

podem ajudar na conservação da umidade do solo assim como na redução de transpiração, 

melhorando a qualidade permanente das formações vegetais inclusive as pastagem ao logo 

dos períodos climáticos, auxilia também no conforto térmico das criações, tem função para o 

produtor como fonte de madeira. 

 Ainda segundo Carpanezzi (2000), mesmo carente de estudos conclusivos existem 

vários indícios de que em regiões tropicais ou subtropicais, o desflorestamento de áreas 

extensas tem forte potencial de causar redução das chuvas, acentuando a estação seca. Na 

Amazônia, a exemplo, aproximadamente 50% da chuva provém do vapor d’agua do oceano, o 

restante provém da própria bacia com significativa participação da evapotranspiração da 

floresta. Com a conversão de mata nativa em pastagem prevê-se a redução total da 

precipitação em 10% a 20 %, um dos fatores mais decisivos nessa alteração sem dúvida é a 

redução da capacidade de infiltração de agua no solo quando da alteração da cobertura vegetal 
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nativa. No exemplo exposto pela Tabela 1, observa-se uma redução de mais de 50% na 

capacidade de infiltração de água da floresta com serapilheira intacta para pastagem 

degradada. 

Tratamento 
Infiltração 

(mm de água/h) 

Solo de floresta com serapilheira intacta 59,9 

Solo de floresta com serapilheira removida mecanicamente 49,3 

Solo de floresta com serapilheira queimada anualmente 40,1 

Pastagem degradada 24,1 

Tabela 1 – Capacidade de infiltração do solo segundo sua cobertura. Media de quatro tipos de solo no centro-

sudeste dos Estados Unidos. Fonte: Embrapa 2000 

 

3.3 Características do sensor TM 

Um dos principais materiais de entrada nos projetos de Sensoriamento Remoto, são as 

imagens geradas por satélites orbitais,  

Liu (2006) faz breve descrição genérica da utilidade de um Satélite.  

O satélite é uma maquina fantástica que possui lentes em vários comprimentos de onda 

eletromagnética e vigia cada pedaço do planeta terra para informar rapidamente e 

minuciosamente o que esta acontecendo nele em uma altitude de 822 quilômetros e em 

uma velocidade que demora de 101,4 minutos para circular o globo terrestre...essas 

lentes vivas são compostas de um conjunto de sensores que captam varias faixas de 

energia da onda eletromagnética, que se originam da radiação solar refletida e emitida. 

(LIU, 2006 p.3) 

 Cada satélite é desenvolvido para finalidades específicas, portanto são várias as 

características encontradas, resolução espacial, temporal, etc. apesar dessa variação, podem 

ser utilizados os diferentes sensores em um único projeto. Segundo Florenzano (2002) o 

sensor multiespectral TM do satélite Landsat-5 é um sistema de varredura que capta dados em 

faixas espectrais diferentes. Conforme os dados disponibilizados pelo INPE (s/d) (Instituto 

Nacional de Pesquisas Espaciais).  

Os sensor TM dos satélites LANDSAT 5 possui sete bandas, com numeração de 1 a 7, 

sendo que cada banda representa uma faixa do espectro eletromagnético captada pelo satélite. 

O período necessário para o satélite revisitar uma mesma área é de 16 dias, também chamado 

de resolução temporal.  



18 
 

As bandas de 1 a 7 apresentadas na Tabela 2 possuem resolução espacial de 30 metros 

o que representa que um pixel tem dimensão em solo de 0,09 hectares.  

Banda 

Intervalo 

espectral 

(µm) 

Principais características e aplicações das bandas TM e ETM 

dos satélites LANDSAT 5 e 7 

1 (0,45 - 0,52) 

Apresenta grande penetração em corpos de água, com elevada transparência, 

permitindo estudos batimétricos. Sofre absorção pela clorofila e pigmentos 

fotossintéticos auxiliares (carotenóides). Apresenta sensibilidade a plumas 

de fumaça oriundas de queimadas ou atividade industrial. Pode apresentar 

atenuação pela atmosfera.  

2 (0,52 - 0,60) 

Apresenta grande sensibilidade à presença de sedimentos em suspensão, 

possibilitando sua análise em termos de quantidade e qualidade. Boa 

penetração em corpos de água.  

3 (0,63 - 0,69) 

A vegetação verde, densa e uniforme, apresenta grande absorção, ficando 

escura, permitindo bom contraste entre as áreas ocupadas com vegetação 

(ex.: solo exposto, estradas e áreas urbanas). Apresenta bom contraste entre 

diferentes tipos de cobertura vegetal (ex.: campo, cerrado e floresta). 

Permite análise da variação litológica em regiões com pouca cobertura 

vegetal. Permite o mapeamento da drenagem através da visualização da 

mata galeria e entalhe dos cursos dos rios em regiões com pouca cobertura 

vegetal. É a banda mais utilizada para delimitar a mancha urbana, incluindo 

identificação de novos loteamentos. Permite a identificação de áreas 

agrícolas. 

4 (0,76 - 0,90) 

Os corpos de água absorvem muita energia nesta banda e ficam escuros, 

permitindo o mapeamento da rede de drenagem e delineamento de corpos de 

água. A vegetação verde, densa e uniforme, reflete muita energia nesta 

banda, aparecendo bem clara nas imagens. Apresenta sensibilidade à 

rugosidade da copa das florestas (dossel florestal). Apresenta sensibilidade à 

morfologia do terreno, permitindo a obtenção de informações sobre 

Geomorfologia, Solos e Geologia. Serve para análise e mapeamento de 

feições geológicas e estruturais. Serve para separar e mapear áreas ocupadas 

com pinus e eucalipto. Serve para mapear áreas ocupadas com vegetação 

que foram queimadas. Permite a visualização de áreas ocupadas com 

macrófitas aquáticas (ex.: aguapé). Permite a identificação de áreas 

agrícolas. 

5 (1,55 - 1,75) 

Apresenta sensibilidade ao teor de umidade das plantas, servindo para 

observar estresse na vegetação, causado por desequilíbrio hídrico. Esta 

banda sofre perturbações em caso de ocorrer excesso de chuva antes da 

obtenção da cena pelo satélite. 

6 (10,4 - 12,5) 

Apresenta sensibilidade aos fenômenos relativos aos contrastes térmicos, 

servindo para detectar propriedades termais de rochas, solos, vegetação e 

água. 

7 (2,08 - 2,35) 

Apresenta sensibilidade à morfologia do terreno, permitindo obter 

informações sobre Geomorfologia, Solos e Geologia. Esta banda serve para 

identificar minerais com íons hidroxilas. Potencialmente favorável à 

discriminação de produtos de alteração hidrotermal.  

Tabela 2 - Principais características dos satélites LANDSAT 5 e 7 

Fonte: INPE - Instituto Nacional de Pesquisas Espaciais (s/d) 
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3.4 Correção Geométrica  

Um dos primeiro passos para utilização das imagens é a realização da correção 

geométrica. Este procedimento tem como objetivo minimizar os efeitos sistemáticos obtidos 

durante a aquisição das imagens. Os principais erros sistemáticos inerentes ao processo de 

aquisição das cenas são devido ao efeito de rotação relativa da Terra em relação ao satélite, as 

distorções panorâmicas que afetam os sensores de amplo ângulo de visada, a curvatura da 

Terra, o efeito de arrastamento da imagem, os ângulos de inclinação e a variação da altitude. 

Ao realizar uma análise multitemporal este procedimento torna-se indispensável, pois as 

cenas devem ser registradas e analisadas para uma mesma posição no espaço (D’ALGE, 

2001). 

3.5 Índices de vegetação 

O monitoramento contínuo da biomassa vegetal no globo terrestre desperta grande 

interesse no homem. A possibilidade de controlar o avanço da supressão ilegal da vegetação é 

um grande anseio dos órgãos ambientais em todo o planeta. No entanto, alguns fatores são 

limitantes na busca desse ideal: a difícil locomoção em campo pelas grandes extensões 

territoriais ocupadas por vegetações nativas, os custos desse monitoramento in loco. A 

segmentação da atuação dispersa dos agentes interventores, entre outros elementos que 

dificultam a atuação do analista ambiental. 

Com o advento das tecnologias de sensoriamento remoto e o acesso ao uso civil dos 

satélites orbitais, esse ideal pretendido de monitoramento da vegetação nativa ganhou forte 

aliado.  

De acordo com Silva (2009), os principais instrumentos do sensoriamento remoto são 

os sensores, que possuem a capacidade de captar a radiação e realizar a conversão em uma 

forma que permita análises e interpretações, sendo estas as imagens. 

A aplicação das técnicas existentes em sensoriamento remoto permite um 

processamento dos dados e cenas provindas dos satélites e sensores, capaz de gerar produtos 

diversos, como por exemplo, a modelagem numérica do terreno, a classificação da cobertura 

do solo e índices de vegetação, sendo este último utilizado para a realização do presente 

trabalho. 
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O ser humano tem certa dificuldade na análise visual de imagens de satélites orbitais 

em grande parte pela limitação física em reconhecer as respostas espectrais. Para o homem o 

campo de percepção de informações visuais se limita à faixa espectral de aproximadamente 

0,4 a 0,7 μm. 

Portanto, para se valer apenas da análise visual da resposta espectral da banda do 

visível, para detecção dos desmatamentos, seriam necessárias imagens de sensores com alta 

resolução espacial. Com elevado custo de aquisição, esse trabalho seria muito lento, ainda que 

significantemente mais barato e ágil que a verificação em campo.  

Foi pensando em dar mais agilidade nessa interpretação e ampliar a gama de escalas 

passíveis de análise, (atuar em escalas menores, reduz o custo de operação e seu tempo) que 

os cientistas desenvolveram os chamados índices de vegetação. 

Os cientistas desenvolveram os índices de vegetação para monitorar e 

quantificar as condições e distribuições espaciais das vegetações, usando os 

dados digitais de refletâncias espectrais da radiação eletromagnética. (LIU, 2006 

p.217) 

Os índices de vegetação são obtidos por variadas combinações matemáticas dos 

diferentes sensores que captam refletâncias em diferentes faixas principalmente a do vermelho 

e infravermelho próximo, são aplicados cálculos matemáticos usando como base os trechos de 

refletância dos sensores orbitais, o resultado dessas combinações tem o objetivo principal de 

homogeneizar as respostas espectrais referentes a vegetação e discriminar do todo. Facilitando 

o estudo do objeto especifico, no caso a vegetação. (LIU, 2006, p.217) 

 

3.5.1 Índice de vegetação pela razão  

O índice de vegetação pela razão (Ratio Vegetation Index – RVI) foi o primeiro índice 

proposto por (PERSON e MILLER 1971 apud LIU, 2006), que é a razão das faixas de NIR e 

VIS representadas pela equação: 

RVI = NIR/VIS 

RVI = Índice de vegetação pela razão  

NIR = Refletância na faixa de infravermelho próximo (0,725 a 1,1 Um) 
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VIS = Refletância na faixa de visível (0,4 a 0,7 Um) 

As folhas verdes absorvem a radiação na faixa de VIS e refletem na faixa NIR. Por 

isso, o RVI pode ser um bom indicador do crescimento da cultura e da estimativa da 

biomassa. (LIU, 2006 p.218) 

 

3.5.2 Índice de vegetação NRVI e PVI 

Os Índices de Vegetação a seguir possuem o objetivo principal de cancelar o efeito do 

brilho do solo e o procedimento é baseado no conceito da linha do solo. Uma linha de solo é 

uma equação linear que descreve o relacionamento entre valores de refletância na banda 

vermelha e infravermelha para pixels de solo exposto. Essa linha é produzida realizando-se 

uma regressão linear simples entre as duas bandas, em uma amostra de pixels de solo exposto. 

Uma vez conhecido o relacionamento, todos os pixels desconhecidos em uma imagem que 

possuem a mesma relação nos valores de refletância no vermelho e infravermelho são 

assumidos como solo exposto. 

Pixels desconhecidos que se distanciam da linha de solo por possuírem valores de reflectância 

maiores na banda infravermelha são assumidos como vegetação. Aqueles pixels que se 

distanciam da linha de solo porque suas reflectâncias na banda vermelha são altas são 

frequentemente assumidos como água.  

• NRVI (Normalized Ratio Vegetation Index): é uma modificação do RVI por meio do 

resultado para RVI -1 normalizado com RVI +1. Essa normalização é similar ao efeito do 

NDVI, pois reduz efeitos de iluminação topográfica, efeitos atmosféricos e cria uma 

distribuição normal estatisticamente desejável. 

• PVI (Perpendicular Vegetation Index): utiliza a distância perpendicular para cada 

coordenada de pixel para a linha de solo. (MARCUSSI, BUENO, MIQUELONI, ARRAES, 

2010, p.45) 

Esses dois índices tem grande utilidade em áreas áridas ou semiáridas onde se tem 

grande exposição do solo, pois a refletância do solo pode interferir na análise, o PVI utiliza 

pontos de amostragem da refletância referentes a solo exposto e subtrai esse resultado do 

índice produto.  
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Para realização desse trabalho foi cogitado a possibilidade de se utilizar esse índice, 

porém a região de estudo, microrregião de Ubá prova desnecessário a aplicação do mesmo, 

visto que a exposição do solo não é presente em meio à vegetação. Totalmente coberta por 

Mata Atlântica, a Zona da Mata de Minas Gerais conta com vegetação arbórea densa. Nem 

mesmo nos períodos secos a vegetação tem perca significativa de biomassa o que 

possibilitaria um solo exposto detectável pela imagem. 

 

3.5.3 Índice de vegetação da diferença normatizada (NDVI)  

 Encerro a apresentação dos índices de vegetação após essa breve exposição, é certo 

que não contemplei sequer parte significativa de todas as metodologias desenvolvidas pelos 

estudiosos nos últimos anos.  

 Todas as metodologias descritas até aqui são fruto de um estudo em busca do que mais 

se adaptaria a minha proposta. Descrevi, pois os mais relevantes, agora vou expor o índice de 

classificação de vegetação mais compatível com minhas propostas e que vai ser usado na 

execução desse trabalho. Atualmente o NDVI é o índice mais usado pelos pesquisadores. 

 O índice de vegetação da diferença normatizada (Normalized Difference vegetation 

index – NDVI) foi proposto por (ROUSE et al. 1973 apud LIU, 2006). O NDVI é calculado 

pela diferença de refletância entre a faixa de NIR e a de VIS. Essa diferença é normatizada 

pela divisão da suma das faixas de NIR e VIS. A equação geral é representada:  

NDVI = (NIR-VIS)/(NIR+VIS) 

NDVI = índice de vegetaçao da diferença normatizada 

NIR = reflectância da faixa de infravermelho próximo (0,725 a 1,10 Um) 

VIS = reflectancia da faixa de visível (0,4 a 0,7 Um) 

[...] A vantagem do NDVI sobre RVI e DVI é que ele elimina parcialmente as 

interferências atmosféricas. Por causa da normatização, os efeitos das 

variações de ângulos solares e ângulo de visada dos sensores também são 

minimizados (HOLBEN, 1986 apud LIU, 2006). 
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 O NDVI, segundo (FREIRE & PACHECO, 2005 apud CABRAL 2012), é um 

indicador de vegetação utilizado para destacar a vegetação ocorrente em uma área. Este 

indicador vegetacional é dado pela razão entre as bandas de alta correlação entre si e serve 

para realçar os alvos de interesse, a biomassa vegetal. Assim sendo, este índice pode ser usado 

no mapeamento da supressão vegetacional, uma vez que se pode comparar o índice de duas 

imagens sobre a mesma área em diferentes períodos, identificando as áreas desmatadas e/ou 

reflorestadas. 

Aplicado nas imagens geradas pelo sensor TM, acoplado ao satélite Landsat 5 (o qual 

vai ser usado para realizar as análises de supressão vegetal desse trabalho), o NDVI é 

representado pela seguinte equação: 

NDVI = (Band4 – Band3)/(Band4 + Band3) 

Onde: 

Band3 = Banda espectral 3 correspondente à região do visível correspondente ao 

vermelho, com comprimento de onda variando entre 0,62 e 0,68 μm. 

Band4 = Banda espectral 4 correspondente à região do infravermelho próximo, com 

comprimento de onda variando entre 0,77 e 0,86 μm. 

Como resultado para essa equação tem-se uma imagem raster, com segmentação das 

respostas espectrais, discriminando as zonas de biomassa vegetal das áreas ausentes de 

vegetação. 

Dessa forma, por meio da aplicação de métodos e equações comparativos do NDVI 

em diferentes períodos pode-se identificar, com certa eficiência, quais as áreas sofreram 

supressão vegetacional. 

A utilização deste satélite e deste sensor se dá devido às suas características de 

resolução espacial de 30m, cobrindo uma cena de 141x141km², servindo perfeitamente para o 

uso da escala 1:60.000, que possibilitem uma análise eficaz sobre a imagem e possibilitam 

realizar esta análise em uma grande área, como é a microrregião de Ubá. 
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3.6 Caracterização da área  

A microrregião de Ubá esta totalmente inserida no bioma Mata Atlântica no 

Zoneamento Ecológico Econômico no Estado de Minas Gerais (ZEE-MG). Localizada na 

porção central da mesorregião da Zona da Mata do estado de Minas Gerais. (OLIVEIRA 2010 

p. 23) Possui uma área total de 3.593,648 km², distribuída entre dezessete municípios. Fazem 

parte desta região os municípios de Ubá, Astolfo Dutra, Divinésia, Dores do Turvo, Guarani, 

Guidoval, Guiricema, Mercês, Piraúba, Rio Pomba, Rodeiro, São Geraldo, Senador Firmino, 

Silverânia, Tabuleiro, Tocantins, Ubá, Visconde do Rio Branco.  

 Dentro do estado, a microrregião de Ubá ocupa a porção sudeste, onde forma uma 

espécie de triângulo quando comparado às distâncias entre as capitais de Espirito Santo, Rio 

de Janeiro e Minas Gerais. De Belo horizonte, Ubá dista aproximadamente 250 Km: Rio de 

Janeiro no sentido sul de Ubá está distante 290 Km, e a capital do Espirito Santo, Vitória 

distante da cidade de Ubá 490 Km. Elemento importante para consolidação do polo moveleiro 

de Ubá. A Figura 1 apresenta sua localização dentro do estado de Minas Gerais. 

 

Figura 1 – Localização da Microrregião de Ubá. Elaborado pelo autor. 
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No entanto é fundamental explicitar que ainda hoje, apesar de possuir destaque 

econômico como maior pólo moveleiro de Minas Gerais, a distância reduzida dos grandes 

centros consumidores e a aparente logística privilegiada é meramente numérica. Quando 

apurada de forma qualitativa, o que se observa são estradas insuficientes com baixa 

manutenção e de pista simples, em grande parte sem acostamento. 

Conforme o gentílico ubaense elaborado pelo Instituto Brasileiro de Geografia e 

Estatística (IBGE, s/d) a ocupação inicial da região se dá entre os séculos XVIII e princípios 

do XIX, sobretudo fomentada pelo declínio de rendimento das áreas de mineração de 

Mariana, Ouro Preto, Guarapiranga e outros centros de extração de ouro na capitania de 

Minas Gerais. Essa queda na produção levou que muitas famílias dependentes dessa forma de 

obtenção de recurso, buscassem as terras ainda devolutas banhadas pelos rios Turvo, Xopotó, 

Pomba e outros, com objetivo de extrair da produção agrícola os recursos necessários a 

manutenção, mais do que isso. As fazendas formadas por esses migrantes logo se 

transformaram em núcleos de população. 

Marcado pelo conflito com grupos indígenas Croatas e Puris, a região foi se 

configurando, fazendo a exemplo de toda formação do território brasileiro, prevalecer às 

investidas do Estado com auxílio da igreja. Onde o massacre eminente dos indígenas dá lugar 

a uma população tradicional estratificada. (IBGE, s/d). 

Segundo Albino (2009 p.75) até a metade do século XIX, a região tinha como base a 

agricultura de subsistência. Com a ascensão do ciclo do café, e o crescimento do plantio dessa 

cultura em direção ao Vale do Paraíba, o domínio da cultura de subsistência dá lugar a uma 

produção massiva de café para exportação, fomentando portanto a criação da ferrovia, 

juntamente com a demanda mais expressiva por mão de obra qualificada acentuando a 

migração interna. 

Junto com o café, tinha-se o cultivo de fumo, produções agrícolas atrativas para 

imigrantes italianos, os quais além de lavradores detinham grande vocação para manufatura e 

trabalho artísticos. Quando da crise do café na década de 1930, o fumo passou a ser o 

principal produto da região, até o ano de 1950, período no qual perdeu aceitação devido à 

baixa combustibilidade, provocado pelo manejo inadequado das lavouras. O declínio dos mais 

importantes meios econômicos da região levou a um desemprego em massa, uma alternativa a 

esse senário foi a formação das primeiras fábricas de móveis, hoje responsável por 65% da 

renda gerada na região, (ALBINO 2009). 
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O pólo moveleiro de Ubá começou a ser constituído em meados da década 

de 60 quando, segundo informantes locais, uma grande empresa de móveis, a 

Dolmani, foi à falência. Os funcionários desta vendo-se desempregados 

montaram suas próprias fábricas de móveis em decorrência do ofício aprendido. 

Com o passar dos anos, o número de empresas foi crescendo, ainda que de forma 

desordenada, com o empirismo e empreendedorismo ainda prevalecendo. 

Passadas quatro décadas, o número de empresas do setor moveleiro na 

microrregião de Ubá faz deste o principal pólo moveleiro de Minas Gerais e o 

terceiro do Brasil,(FANDIÑO, 2005, p.69) 

Hoje dos dezessete municípios da microrregião de Ubá, nove constituem o pólo 

moveleiro de Ubá sendo estes: Ubá, Guidoval, Guiricema, Piraúba, Rio Pomba, Rodeiro, São 

Geraldo, Tocantins e Visconde do Rio Branco. O que ratifica a posição privilegiada de Ubá 

como centro econômico da microrregião. 

No ZEE-MG, o tutorial para o componente produtivo, mostra que os municípios da 

mesorregião da Zona da Mata possuem indicadores bastante heterogêneos que variam entre 

“muito precárias” (E) a “muito favoráveis” (A), porém, predominando a categoria (E). 

 Observando a Tabela 3 abaixo nota-se que nenhum dos municípios pertencentes ao 

pólo moveleiro de Ubá apresenta classificação de “muito precária”, estando os municípios de 

Tocantins e Rodeiro com as maiores necessidades de ações para o nivelamento com a média 

de classe dos municípios restantes. (OLIVEIRA, 2010, p.25) 

 

Tabela 3 - Categorização quanto ao potencial produtivo dos municípios pertencentes ao pólo moveleiro de Ubá, 

segundo o ZEE – MG Fonte: EPAMIG Série Documentos, nº. 47, 2010. 
 

Santos (2013) faz uma caracterização do efeito da indústria moveleira sobre o êxodo 

rural, segundo este a estabilidade alcançada ao longo das décadas pela indústria moveleira na 

região, associado com os fornecedores de matéria prima e tecnologias, fez com o meio urbano 

se tornasse muito atrativo para as pessoas, que saem da zona rural em busca de emprego e 
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melhores condições de vida. Dessa forma, percebe-se através dos dados populacionais do 

município, que o êxodo rural, principalmente a partir da década de 1990 foi muito intenso 

havendo consequentemente um esvaziamento do campo como pode ser acompanhado ao 

longo do trabalho. 
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4 Materiais e métodos  

4.1 Mapeamento das áreas de supressão de mata nativa  

O mapeamento de áreas de supressão de mata nativa consistiu na comparação entre 

imagens de satélite (Landsat 5) de uma mesma localidade com períodos distintos. Subsidiado 

pelo índice de vegetação NDVI, a fim de averiguar as alterações sofridas na vegetação nativa 

ao longo desse período culminando no mapeamento dessas áreas. Como o período de análise 

foi de 1996 a 2004 foram necessárias 14 imagens. 

As imagens utilizadas na pesquisa (Tabela 4) para a etapa do levantamento de 

desmatamento acumulado, foram providas do satélite LANDSAT 5 sensor  MT. Os softwares 

utilizados no processamento das imagens e mapeamento foram respectivamente o ENVI 4.5 ® 

e o ArcGIS 10 ® ambos desenvolvidos pela ESRI ®.  

IMAGENS PERÍODO 

LANDSAT_5_TM_19960718_217_075_L2 
18/07/1996 

LANDSAT_5_TM_19960718_217_074_L2 

LANDSAT_5_TM_19970603_217_075_L2 
03/06/1997 

LANDSAT_5_TM_19970603_217_074_L2 

LANDSAT_5_TM_19990812_217_075_L2 
12/08/1999 

LANDSAT_5_TM_19990812_217_074_L2 

LANDSAT_5_TM_20000627_217_075_L2 
27/06/2000 

LANDSAT_5_TM_20000627_217_074_L2 

LANDSAT_5_TM_20010427_217_075_L2 
27/04/2001 

LANDSAT_5_TM_20010427_217_074_L2 

LANDSAT_5_TM_20030706_217_075_L2 
06/07/2003 

LANDSAT_5_TM_20030706_217_074_L2 

LANDSAT_5_TM_20040910_217_075_L2 
10/09/2004 

LANDSAT_5_TM_20040910_217_074_L2 
Tabela 4 - Imagens utilizadas na pesquisa e seus respectivos períodos de imageamento 

Fonte: Elaborada pelo autor 

 

Para abranger toda a área de estudo, no caso, a microrregião de Ubá na Zona da Mata 

de Minas Gerais, foram necessárias duas cenas para cada período. A cena de órbita 217 e 

ponto 075 referente à porção sul da microrregião. Assim como a cena de órbita 217 ponto 074 

responsável por recobrir uma pequena faixa do setor norte da microrregião de Ubá. Para 

realizar o NDVI o requisito mínimo em qualquer imagem de satélite que se esteja 

trabalhando, são as bandas referentes ao vermelho e infravermelho próximo, no entanto para 

obter uma imagem mais robusta capas de outras análises complementares como a composição 
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RGB 321 cor natural. Procedeu à obtenção das bandas 1, 2, 3 e 4 para todas as imagens 

trabalhadas na pesquisa. As imagens referidas são disponibilizadas gratuitamente pelo site do 

Instituto Nacional de pesquisas Espaciais. 

 

4.1.1 Aquisição de imagens 

O único requisito para acessar as imagens é um cadastro realizado no próprio site, 

onde o usuário define o e-mail no qual deseja receber o download das imagens de interesse. 

Em seguida o usuário deve realizar sua pesquisa no campo “Parâmetros Básicos”, 

onde é possível definir alguns parâmetros como, satélite e sensor a ser utilizado, órbita, ponto, 

quantidade máxima tolerada de nuvens, e demais parâmetros. Na pesquisa foi estipulada 

porcentagem máxima de 20% de cobertura de nuvens para cada cena. Em razão do elevado 

índice de nebulosidade da região, os anos de 1998 e 2002 não tiveram imagens com padrão 

mínimo tolerável de cobertura de nuvens para realizar a apreciação do trabalho, porém, como 

a pesquisa objetivou apenas levantar o volume acumulado do desmatamento no período 1996 

ate 2004, não se faz necessário a apreciação ano a ano. Uma vez que toda alteração sofrida na 

região no ano 1998 e 2002 pode ser detectadas respectivamente pelas imagens de 2003 e 

2004. Não trazendo prejuízo ao resultado final.  

Serão enviadas duas mensagens para o email cadastrado, o primeiro contendo a 

confirmação do pedido e o segundo contendo o link para a página de download das imagens 

(o segundo email pode demorar alguns minutos para chegar). Clique no link para ser 

endereçado à página de download das imagens pedidas. O download é feito por bandas 

separadamente, portanto devem-se baixar todas as bandas necessárias para a aplicação 

desejada. Com a obtenção das bandas 1, 2, 3 e 4 na junção das bandas o produto vai ser um 

arquivo mais robusto possibilitando uma análise mais diversificada, evitando um retrabalho 

futuro. 

4.1.2 Composição de bandas  

Em poder das imagens pretendidas, agora inicia a etapa de processamento das 

mesmas. As imagens baixadas anteriormente devem ser juntadas em um único arquivo para 
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que possam ser mais facilmente manipuladas posteriormente. Para isso foi utilizado o 

software ENVI 4.5 ®. 

Inicie o programa; Adicione as bandas a serem unidas (File => Open Image File 

selecione as bandas que deseja unir => Abrir); Automaticamente se abrira a janela Avaliable 

Band List contendo as bandas adicionadas.  

Com as bandas disponíveis para manipulação inicia-se o processo de junção: Basic 

Tools => Layer Stacking; Na janela “Layer Stacking Parameters” clique em Import File...; 

na janela seguinte selecione as bandas a serem juntadas. As bandas selecionadas estarão 

aparecendo em “Selected Files for Layer Stacking”, caso esteja faltando alguma banda, repita 

a operação anterior e adicione-a; Clique em Reorder Files para reordenar a posição das 

bandas (comumente no ENVI, a ordem das bandas é decrescente, no entanto para facilitar a 

manipulação posterior e evitar confusão envolvendo a nomenclatura das bandas, aconselha-se 

organizá-las em ordem crescente, como os demais programas normalmente trabalham) e 

coloque-as em ordem crescente; Depois de reordenadas as bandas selecione em “Output 

Results to:” adotar a opção Memory, deixe os demais itens como estão (uma vez que o ENVI 

os organiza de acordo com o padrão das bandas que foram juntadas) e clique em OK; Na 

janela seguinte selecione novamente a opção Memory e clique em OK; Aguarde o 

processamento.  

Esse procedimento foi realizado, pois os arquivos salvos diretamente pelo ENVI 4.5 

não são compatíveis com o ArcGIS 10® ( caso o software utilizado fosse o ArcMap 9.3® o 

arquivo Memory poderia ser exportado diretamente do ENVI 4.5® para o ArcMap 9.3® 

facilitando a operação. A versão do ArcMap 10 não comunga essa compatibilidade com sua 

antecessora) 

A imagem juntada estará disponível na janela “Avaliable Band List”. Após a junção 

das bandas e a criação de um novo arquivo contendo todas juntas, os arquivos das bandas 

separadas podem ser retirados do programa, para isso clique com o botão direito do mouse 

sobre o nome da banda e clique em Close Selected File, deixando na janela apenas a imagem 

juntada. 
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4.1.3 Correção radiométrica 

A correção radiométrica consiste na tentativa de minimizar os efeitos atmosféricos 

contidos na imagem. Existem diferentes tipos de correções que serão usadas de acordo com a 

necessidade do analista e com as condições presentes na imagem. Para o presente estudo foi 

escolhido o processo de subtração do pixel escuro ou “Dark Pixel Subtract”. Este processo foi 

escolhido devido a sua facilidade de aplicação e também devido ao fato de realizar o mesmo 

tipo de correção em todas as imagens padronizando os resultados.  

Para a realização da subtração do pixel escuro é necessário saber o valor deste pixel 

para cada uma das bandas contidas na imagem, para isso deve-se gerar um arquivo texto do 

histograma da imagem para que se possa, por meio deste arquivo, localizar o pixel escuro e 

realizar a subtração.  

Com a imagem a ser corrigida disponível em Avaliable Band List, clique em Basic 

Tools => Statistics => Compute Statistics. Na janela Compute Statistics Input File, selecione 

o arquivo Memory 1 (gerado anteriormente) e clique em OK. Já na janela Compute Statistics 

Parameters marque as caixas Basic Stats, Histograms e Output to a Text Report File, 

desmarque o restante; Clique em Choose para escolher a pasta onde será salvo o arquivo texto 

com o histograma da imagem (recomenda-se colocar este arquivo na mesma pasta em que 

estão as bandas baixadas) e clique em OK. O arquivo resultado será do tipo .txt e terá os 

valores de reflectância para cada nível de cinza. 

Para realizar a subtração do pixel escuro clique Basic Tools => Preprocessing => 

General Porpouse Utilities => Dark Subtract; Na janela Dark Subtract Input File, selecione 

o arquivo a imagem que será corrigida (Memory 1) e clique em OK. Abrir-se-á a janela Dark 

Subtraction Parameters, nela selecione a opção User Value digite os valores contidos no 

arquivo texto do histograma para cada banda*; Após colocar o valor correspondente a cada 

banda, no campo Output Result to, selecione File, clique em Choose, escolha a pasta onde o 

arquivo será salvo, dê um nome a este arquivo (aconselha-se colocar “órbita/ponto_data de 

aquisição da imagem_cor”, estas informações estão disponíveis no nome do arquivo da banda 

baixada), clique em OK. Aguarde o processamento (pode demorar alguns minutos). 

A nomenclatura das bandas é dada automaticamente pelo programa e não diz respeito 

à nomenclatura real, esta nomenclatura será alterada posteriormente, no entanto para o 
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presente procedimento siga a nomenclatura dada pelo programa uma vez que o histograma 

também obedece a essa nomenclatura.  

* O pixel escuro é identificado na imagem como o primeiro DN que apresentar pelo 

menos duas casas decimais na coluna Percent. 

O arquivo gerado será automaticamente aberto na janela Avaliable Band List; Agora o 

arquivo memória pode ser excluído; Clique com o botão direito sobre Memory 1 => Close 

Selected File. 

O arquivo gerado e corrigido deverá ter sua nomenclatura alterada para a 

nomenclatura real do sensor LANDSAT 5, para não gerar confusão envolvendo o nome da 

banda e sua aplicação. Para isso clique com o botão direito do mouse sobre o nome do 

arquivo a ser alterado e clique em Edit Header. Na janela seguinte clique em Edit Atributes 

=> Band Names. A janela Edit Band Names Value se abrirá, nela selecione a banda que terá 

seu nome trocado e digite o novo nome, clique em OK e em OK novamente. Repare, na janela 

Avaliable Band List, que as bandas tiveram seu nome alterado. 

4.1.4 Correção geométrica 

Outra correção necessária a se fazer é a correção geométrica da imagem, o chamado 

Georreferenciamento. Esta correção coloca a imagem na sua exata posição espacial e 

propiciará uma análise mais precisa sobre a imagem, posicionando na mesma posição todas as 

imagens de períodos distintos. 

Essa correção foi feita sobre as imagens georreferenciadas do satélite RapidEye do ano 

2009 fornecidas pelo CEDEF/IEF (Centro de Estudos e Desenvolvimento Florestal/Instituto 

Estadual de Florestas) onde foram criadas imagens base georreferenciadas para criar um 

padrão de registro, crucial nesse tipo de processamento realizado. 

Para iniciar o processo abra a imagem juntada e corrigida no ENVI 4.5 (Caso esta não 

esteja aberta), caso o ArcGIS® utilizado fosse o 9.3 poderia ser exportada diretamente. No 

entanto como os software utilizados foram ENVI 4.5® e ArcMap 10®. Para tornar o arquivo 

processado no ENVI 4.5® comparável com o ArcMap 10®. Deve-se após abrir o arquivo 

juntado e corrigido salva-lo no formato .tif. File => Save File As => TIFF/GeoTIFF. Nesse 
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formato o arquivo esta compatível com o ArcMap 10®. E pode ser aberto diretamente pelo 

programa.   

  Abra a imagem base georreferenciada da mesma órbita/ponto da imagem exportada. 

Add Data=> Selecione a imagem base => Add.  

Para saber qual órbita/ponto terá a sua imagem base, observe a nomenclatura das 

bandas baixadas na primeira parte deste texto.  

Em Layer selecione a imagem a ser georreferenciada, ;Clique em Add Control Points 

para adicionar os pontos de controle necessário ao registro; clique em Window => Magnifer 

para ativar a janela de zoom (se preferir dê o zoom pelo scroll look do mouse); clique uma 

vez na imagem a ser referenciada para adicionar um ponto de controle; ative a imagem base 

georreferenciada e dê um clique no mesmo ponto da imagem anterior; repita as operaçõespara 

criar os outros pontos de controle na imagem. 

São necessários no mínimo 4 pontos de controle bem distribuídos na imagem para que 

o georreferenciamento seja satisfatório. Sendo aconselhável criar uma quantidade maior de 

pontos para uma maior precisão do georreferenciamento. 

Aconselha-se criar os pontos nas extremidades da imagem para uma maior precisão do 

georreferenciamento. 

Após a criação dos pontos de controle, necessita-se verificar seu erro médio de 

posicionamento RMS para averiguar a qualidade do georreferenciamento. Caso este esteja 

dentro do erro aceitável, deve-se validar o georreferenciamento. 

Para facilitar o posterior trabalho de verificação dos polígonos, recomenda-se um erro 

menor que 1. 

Clique em View Link Table para abrir a tabela com as especificações dos pontos de 

controle, na tabela em Transformation deixe em 1st Order Polynomial e a caixa Auto Adjust 

marcada; verifique o erro em Total RMS Error, se este for menor que 1 o georreferenciamento 

pode ser validado, então clique em OK. Caso o erro seja maior que 1, selecione o ponto com 

maior resíduo e o exclua, crie um outro ponto e verifique novamente o erro total, repita esta 

operação até o erro total estar dentro do aceitável. 
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Com o erro residual médio dentro dos padrões aceitáveis valide o 

georreferenciamento.  

Clique em Georeferencing => Update Georeferencing ; Repare que os pontos de 

controle desaparecerão da imagem e algumas opções como o próprio Update Georeferencing 

ficarão indisponíveis para utilização. Sua imagem está registrada.  

4.1.5 Criação do NDVI 

Após as fases anteriores de download e junção das bandas, correção radiométrica e 

correção geométrica o NDVI já pode ser criado. 

Abra a imagem georreferenciada no ENVI 4.5 (File => Open Image File => 

selecione o arquivo desejado => abrir); Observe que o nome das bandas da imagem seguem 

os padrões salvos pelo ArcGIS®, sendo necessário realizar a mudança nesses nomes para que 

não ocorra nenhuma troca ou confusão na hora da aplicação do NDVI. Para isso realize as 

operações descritas anteriormente em na etapa de “Correções Radiométricas” clicando com o 

botão direito do mouse sobre o nome da imagem => Edit Header => Edit Atributes => Band 

Names. 

Para criar o NDVI clique em Basic Tools => Band Math; na janela seguinte, no 

campo Enter na expression digite a equação usada na geração do NDVI que baseia-se na 

relação dos valores flutuantes de reflectância dos pixels das bandas 3 e 4 correspondentes à 

região espectral do Vermelho e do Infra-Vermelho Próximo, sendo ela: 

 (float(b1)-b2) / (float(b1)+b2)  

Clique em Add to List para adicioná-la ao campo Previous Band Math Expressions 

tornando possível o seu uso; clique na expressão dentro da caixa Previous Band Math 

Expressions e em seguida clique em OK. 

Na janela Variables to Band Pairings em Variables used in expression selecione B1 e 

em Available Band List clique em Banda 4; em seguida selecione B2 e clique em Banda 3. 

Em Output Results to selecione File; Clique em Choose e escolha a pasta e o nome do arquivo 

a ser gerado (aconselha-se escolher a pasta onde foram salvas as bandas baixadas e os 

arquivos gerados até o momento. Para o nome aconselha-se colocar “órbita/ponto_data de 

aquisição da imagem_NDVI”). 
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Após o término do processamento o arquivo contendo o NDVI automaticamente ficará 

disponível na janela Avaliable Band List, é necessário então fazer uma checagem de sua 

localização e qualidade. Para isso deve-se comparar a imagem gerada com o arquivo base, 

usado em sua geração. 

Selecione a opção RGB Color ; Clique na opção R e selecione a Banda 4 em G 

selecione a Banda 3 e em B selecione a Banda 2, clique em Load RGB, repare que se abrirá 

um visualizador com a composição colorida aplicada. Clique com o botão direito sobre o 

nome da imagem NDVI=> Load Band to New Display para abrir a imagem NDVI no 

visualizador; Clique com o botão direito sobre um dos visualizadores => Geographic Link; na 

janela que se abrir altere as opções para ON e dê OK; Clique em qualquer parte de um dos 

visualizadores e observe que o outro também se moverá; compare as imagens e observe se 

elas estão posicionadas na mesma posição geográfica (use esquinas e pontos conhecidos para 

fazer esta identificação.). 

4.1.6 NDVI Diferença  

O NDVI diferença consiste na equação básica de subtração dos valores dos pixels de 

uma imagem de determinada data por outra imagem do mesmo local em uma data anterior. 

Essa diferença mostrará pontos de supressão e/ou regeneração da vegetação baseado nos 

valores do NDVI. 

Abra duas imagens NDVI da mesma órbita/ponto de datas diferentes (File => Open 

Image File => selecione os arquivos NDVI a serem usados para a realização do NDVI 

diferença => Abrir). Com os arquivos disponíveis na janela Avaliable Band List clique em 

Basic Tools => Change Detection => Compute Diference Map. 

Primeiramente se abrirá a janela Select the “Initial State” Image, nela selecione o 

NDVI da imagem com data mais recente e clique em OK; na janela seguinte Select the “Final 

State” Image, selecione o NDVI da imagem com data mais antiga e clique em OK. Abrirá a 

janela Compute Diference Map Input Parameters, em Number of Classes coloque o número 

7, em Change Type deixe em Simple Diference, em Output Results to, marque Memory, em 

Save Auto-Corregistred Input Images? marque No e dê OK. Na janela ENVI Output to 

Memory Warning marque Memory e dê OK. Aguarde o processamento. 
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O arquivo criado automaticamente será incluído na janela Avaliable Band List, com o 

arquivo disponível, repita a operação para salvar em formato .tif, compatibilizando o arquivo 

com o ArcMap 10. File => Save File As => TIFF/GeoTIFF. 

Clique em Add Data => selecione a imagem do mês inicial=> Abrir. Repita a operação 

adicionando a imagem do mês final. 

Com as imagens adicionadas faça a composição de bandas RGB 432 clicando com o 

botão direito sobre o nome da camada => Properties => Symbology =>RGB composite, e 

alterando as bandas de cada canal e clicando em OK. 

Após a realização desta composição nas duas imagens base, verifique o 

posicionamento do NDVI diferença baseado nas imagens base. Para isso procure pontos de 

fácil identificação e observe se as imagens estão sobrepostas ativando e desativando as layers 

sem alterar a posição da imagem. 

4.1.7 Criação dos polígonos 

Para a criação dos polígonos, é necessário utilizar o NDVI diferença e as imagens base 

e referência, utilizadas no processo anterior.  

Adicione o NDVI diferença referente a um determinado período e as imagens do mês 

base e do mês referência. Para isso clique em Add data => selecione as imagens => Abrir O 

NDVI diferença estará dividido em 7 variações de cores, mas a diferença negativa (supressão 

vegetacional) estará majoritariamente inclusa nas variações 1 e 2. 

Para identificar as áreas de supressão vegetacional deve-se então usar como base 

apenas as variações 1 e 2. “Desligue” as demais variações e coloque em amarelo as variações 

1 e 2. Para isso clique com o botão direito do mouse sobre a cor da variação e altere as cores 

dos números 0, 3, 4, 5, 6 e7 para No Color, do número 1 e 2 para amarelo. 

Para que o NDVI diferença fique sobreposto às imagens, o layer contendo esta camada 

deve ficar acima dos demais layers. 

O arquivo de polígono deve ser criado a partir de um novo shapefile. Este shapefile 

deve ser criado por meio do ArcCatalog. Para isso abra o ArcCatalog, presente no ArcMap 
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10. No ArcCatalog, abra a pasta onde os arquivos anteriores foram salvos. Nesta pasta clique 

com o botão direito do mouse em uma área qualquer => New => Shapefile. 

Na janela Create New Shapefile, em Name de um nome ao novo shapefile Em Feature 

Type coloque Polygon. É necessário indicar a projeção em que a shapefile estará, para isso 

clique em Edit. Na janela que se abrirá, Spatial Reference Properties clique em Import, na 

próxima janela, Browse for Dataset selecione o NDVI diferença que servirá de base e clique 

em Add. Clique em OK e em OK novamente. O shapefile criado ficará disponível no 

ArcCatalog. 

De volta ao ArcMap adicione o shapefile dos polígonos recém criados ao projeto (que 

já contem os arquivos referentes ao NDVI diferença de determinado período, mês base do 

desmatamento e mês referência ao desmatamento.) 

Os polígonos serão criados com base nas áreas indicadas pelo NDVI diferença (áreas 

em amarelo), o que não quer dizer que é exatamente a área amarela correspondente ao 

desmatamento. Para aferir a existência ou não do desmatamento, deve-se comparar as 

imagens dos meses utilizados na elaboração do NDVI diferença e as áreas apontadas pelo 

NDVI diferença como áreas de desmatamento.  

A imagem abaixo (Figura 2) obtida no dia 27/06/2000 apresentada em composição 

RGB 432, mostra uma área de mata nativa preservada, circunscrita por uma linha pontilhada 

preta. 

 

Figura 2 – Área com mata nativa. Fonte: Landsat5 - 27/06/2000 
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A próxima imagem (Figura 3) também em composição RGB 432, apresenta a mesma 

área, agora alterada, em função da supressão de mata nativa ocorrida no intervalo 27/06/2000 

– 27/04/2001 data da nova imagem, a supressão detectada nesse caso foi de 2,28 hectares. 

 

Figura 3 – Área de supressão de mata nativa.  

Fonte: Landsat5 - 27/04/2001 

 

Para ratificar a importância da necessidade de intervenção humana no processo de 

criação de polígonos nas áreas detectadas pelo NDVI como possível local de alteração de 

cobertura vegetal, a imagem (Figura 4) na composição RGB 432, apresenta a mesma 

localidade, agora acrescida do NDVI diferença (amarelo).  das imagens 27/06/2000 e 

27/04/2001.  

 

Figura 4 – Área de supressão de mata nativa / NDVI.  

Fonte: Landsat5 - 27/04/2001 

 

Como pode ser observado, apesar de ter localizado o ponto de intervenção, o NDVI 

não foi capas de mensurar com exatidão a área alterada, caso fosse assumido como verdade 
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apenas o ponto em amarelo a área alterada detectada não ultrapassaria um hectare contra os 

2,28 hectares que realmente foram suprimidos.   

Para iniciar a criação dos polígonos, coloque a layer contendo o shapefile dos 

polígonos em edição clicando em Editor => Start Editing. Na janela que se abrirá selecione 

em Which folder or database do you want to edit data from? selecione uma pasta de modo 

que a layer contendo os polígonos apareça em These layers and tables currently in your map 

reside in the source selected above, clique em OK. 

Caso a barra de edição não esteja ativada, clique com o botão direito do mouse sobre 

uma área livre na área das barras de ferramentas e ative-a (a exemplo do realizado para a 

correção geométrica). 

Para criar corretamente os polígonos dentro da layer destinada a eles, certifique-se que 

a layer dos polígonos esteja marcada em Target, em Task marque Create New Feature e 

clique no ícone Sketch Tool para iniciar a criação dos polígonos. 

Com a opção Sketch Tool ativada comece a criar os polígonos clicando na imagem, 

quando for necessário fechar o polígono dê dois cliques em um ponto ou clique com o botão 

direito => Finish Sketch ou aperte F2. 

Crie todos os polígonos que achar necessário, levando em consideração seu 

conhecimento acerca de áreas agrícolas, áreas cobertas por nuvens, etc., após criá-los paralise 

e salve a edição clicando em Editor => Stop Editing, na janela Save aparecerá a pergunta Do 

you want to save your edits? Clique em Sim para salvar a edição. 

Caso deseje salvar a edição e continuar a criação e edição de polígonos, basta clicar 

em Editor => Save Edits e continuar sua edição. 
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5 Resultados e Discussão 

5.1 Dados do desmate 

O presente trabalho não pretende fazer um juízo de valor quanto ao desmatamento 

aqui mensurado. A única forma de análise foi via sensoriamento remoto, logo não foi feita 

qualquer apuração quanto à legalidade das supressões detectadas.  

A lei Nº 11.428, de 22 de dezembro de 2006 que dispõe sobre a utilização e proteção 

da vegetação nativa do Bioma Mata Atlântica, ainda que amplamente restritiva quanto a 

supressão de mata nativa,  guarda algumas possibilidades para autorizar o desmate em área de 

domínio do Bioma Mata Atlântica, conforme dispõem os seguintes artigos: 

Art. 8  O corte, a supressão e a exploração da vegetação do Bioma Mata Atlântica 

far-se-ão de maneira diferenciada, conforme se trate de vegetação primária ou secundária, 

nesta última levando-se em conta o estágio de regeneração.  

Art. 20.  O corte e a supressão da vegetação primária do Bioma Mata Atlântica 

somente serão autorizados em caráter excepcional, quando necessários à realização de 

obras, projetos ou atividades de utilidade pública, pesquisas científicas e práticas 

preservacionistas.  

Parágrafo único.  O corte e a supressão de vegetação, no caso de utilidade pública, 

obedecerão ao disposto no art. 14 desta Lei, além  da realização de Estudo Prévio de 

Impacto Ambiental/Relatório de Impacto Ambiental - EIA/RIMA.   

Art. 21.  O corte, a supressão e a exploração da vegetação secundária em estágio 

avançado de regeneração do Bioma Mata Atlântica somente serão autorizados:  

I - em caráter excepcional, quando necessários à execução de obras, atividades ou 

projetos de utilidade pública, pesquisa científica e práticas preservacionistas; 

Isso observado é provável que alguns ou até mesmo todos os pontos de desmatamento 

detectados, tenham ocorridos de forma legal, amparados por legislação específica e 

instrumentos administrativos.  

 A partir desta análise optou-se por não revelar as coordenadas dos focos de 

desmatamento levantados, apresentando apenas as áreas alteradas em hectare e metros 

quadrados por foco, o período entre o qual ocorreu a alteração, e o município onde está 
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alteração foi detectada, essa medida foi tomada com intuito de preservar a integridade dos 

agentes envolvidos. 

A pesquisa para obtenção do desmatamento teve como área de abrangência a 

microrregião de Ubá composta por seus 17 municípios, distribuídos em uma área total de 

3.593,648 km². O período de analise que foi do dia 18/07/1996 até 10/09/2004 completando 

aproximadamente nove anos, a Tabela 5 e Figura 11 apresentam todos os 86 focos de 

desmatamento encontrados pela pesquisa. 

Município Período Área (Ha) Área (m) 

Astolfo Dutra 1996 - 1997 3,2040 32040,36 

Astolfo Dutra 1996 - 1997 3,8638 38638,46 

Astolfo Dutra 1997 - 1999 0,7007 7007,18 

Astolfo Dutra 1997 - 1999 0,9442 9441,88 

Astolfo Dutra 1997 - 1999 1,0293 10293,03 

Astolfo Dutra 1997 - 1999 1,8260 18260,23 

Astolfo Dutra 1997 - 1999 2,3709 23708,61 

Astolfo Dutra 1997 - 1999 2,9320 29320,29 

Astolfo Dutra 1997 - 1999 3,0589 30588,78 

Astolfo Dutra 1997 - 1999 8,1051 81051,03 

Astolfo Dutra 1997 - 1999 9,3438 93438,26 

Astolfo Dutra 2000 - 2001 0,9282 9281,82 

Divinésia 1996 - 1997 0,6004 6004,33 

Divinésia 1996 - 1997 0,6918 6918,03 

Divinésia 1997 - 1999 1,2481 12480,67 

Divinésia 1997 - 1999 2,1404 21404,23 

Divinésia 1997 - 1999 3,4798 34798,36 

Divinésia 2000 - 2001 0,8367 8367,42 

Divinésia 2000 - 2001 2,2848 22847,56 

Dores do Turvo 1996 - 1997 3,9420 39419,71 

Dores do Turvo 1997 - 1999 3,1592 31591,69 

Dores do Turvo 1999 - 2000 1,4797 14797,47 

Dores do Turvo 1999 - 2000 2,3365 23365,31 

Dores do Turvo 1999 - 2000 2,8860 28860,08 

Dores do Turvo 1999 - 2000 3,6818 36818,31 

Dores do Turvo 2000 - 2001 3,1616 31615,81 

Dores do Turvo 2001 - 2003 3,1908 31908,40 

Dores do Turvo 2001 - 2003 5,8802 58802,24 

Guarani 1997 - 1999 2,1932 21932,08 

Guarani 1997 - 1999 2,9612 29612,26 

Guarani 1999 - 2000 1,7815 17814,86 

Guidoval 2001 - 2003 1,1507 11507,29 
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Guiricema 1997 - 1999 2,8609 28609,35 

Guiricema 2000 - 2001 1,1877 11876,57 

Guiricema 2000 - 2001 1,4430 14430,04 

Mercês 1997 - 1999 1,8097 18096,93 

Mercês 1997 - 1999 1,9285 19284,59 

Mercês 1997 - 1999 10,7780 107779,92 

Mercês 1999 - 2000 1,7562 17562,49 

Mercês 2000 - 2001 3,2572 32571,51 

Mercês 2003 - 2004 3,5424 35424,45 

Piraúba 1996 - 1997 1,7577 17577,33 

Piraúba 1996 - 1997 2,0533 20533,28 

Piraúba 1997 - 1999 1,8810 18809,53 

Piraúba 1999 - 2000 1,7894 17894,04 

Piraúba 1999 - 2000 2,7153 27152,82 

Piraúba 2000 - 2001 4,6319 46318,64 

Rio Pomba 1996 - 1997 1,3566 13565,69 

Rio Pomba 1996 - 1997 3,0879 30879,09 

Rio Pomba 1997 - 1999 2,8058 28058,41 

Rio Pomba 2000 - 2001 1,5182 15181,60 

Rodeiro 1996 - 1997 0,8366 8366,39 

Rodeiro 1997 - 1999 5,1529 51529,49 

Senador Firmino 1996 - 1997 2,4518 24517,67 

Senador Firmino 1997 - 1999 0,8868 8867,84 

Senador Firmino 1997 - 1999 3,1829 31829,22 

Senador Firmino 1999 - 2000 1,4118 14118,28 

Senador Firmino 2000 - 2001 0,9145 9144,96 

Senador Firmino 2001 - 2003 3,4709 34709,29 

Silveirânia 1996 - 1997 2,3695 23694,50 

Silveirânia 1997 - 1999 1,6073 16072,96 

Silveirânia 1997 - 1999 4,4715 44715,30 

Silveirânia 1997 - 1999 16,2781 162780,52 

Tabuleiro 1997 - 1999 0,9976 9976,32 

Tabuleiro 1997 - 1999 1,6731 16731,12 

Tabuleiro 1997 - 1999 1,8290 18289,93 

Tabuleiro 1997 - 1999 2,1794 21793,52 

Tabuleiro 1997 - 1999 9,6702 96701,71 

Tocantins 1999 - 2000 3,2050 32050,05 

Tocantins 2000 - 2001 1,8889 18889,32 

Ubá 1996 - 1997 7,9743 79742,81 

Ubá 1997 - 1999 0,7649 7649,26 

Ubá 1997 - 1999 2,4896 24896,27 

Ubá 1997 - 1999 2,7870 27870,36 

Ubá 1997 - 1999 4,7759 47758,68 
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Ubá 1997 - 1999 9,2969 92968,53 

Ubá 1999 - 2000 0,9879 9878,90 

Ubá 1999 - 2000 1,6159 16158,64 

Ubá 1999 - 2000 3,9237 39237,23 

Ubá 1999 - 2000 4,5057 45056,76 

Ubá 2000 - 2001 0,5305 5304,87 

Ubá 2001 - 2003 2,5653 25653,40 

Visconde do Rio Branco 1997 - 1999 2,0744 20744,42 

Visconde do Rio Branco 1997 - 1999 2,1152 21152,37 

Visconde do Rio Branco 1997 - 1999 3,8401 38400,93 

Tabela 5 - Focos de desmate da microrregião de Ubá de 1996 – 2004 

Fonte: Elaborado pelo autor 

   Aplicada a metodologia proposta de detecção das alterações na cobertura 

vegetal natural, os resultados ainda que expressivos, não foram tão alarmantes, com um 

somatório de 255,7 hectares detectados de supressão de mata nativa. Tabela 6, em uma região 

de 3.593,648 km², distribuídos em 86 focos de supressão Tabela 5 e Figura 11. 

 

Desmate acumulados 1996 - 2004 (Ha) 

Município Total 

Visconde do Rio Branco 8,0297 

Ubá 42,2176 

Tocantins 5,0939 

Tabuleiro 16,3493 

Silveirânia 24,7264 

Senador Firmino 12,3187 

São Geraldo 0 

Rodeiro 5,9895 

Rio Pomba 8,7685 

Piraúba 16,2643 

Mercês 23,072 

Guiricema 5,4916 

Guidoval 1,1507 

Guarani 6,9359 

Dores do Turvo 29,7178 

Divinésia 11,282 

Astolfo Dutra 38,3069 

Total Geral 255,7148 

Tabela 6 – Total desmatado por município 1996 – 2004 Fonte: Elaborado pelo autor 
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Exposto o recorte temporal, e espacial, essa alteração não representou para a região, 

uma área tão elevada de expansão das áreas de produção agrícola, somente 0,07% da área 

total foi alterada. Situação mais drástica pode ser observada, especialmente quando 

comparado a outros biomas menos amparados pela lei, como o caso do cerrado, onde apenas 

em um ano entre 2001 e 2002 segundo Ferreira (2007) o bioma teve uma redução de vegetal 

nativa de 3% da área total coberta pelo cerrado. Com um valor absoluto de 58.889 km² de 

área suprimida detectada nos 2 milhões de quilômetros quadrados totais. 

 Todavia é indispensável relativizar esse dado, tirando de uma mera perspectiva de 

comparação de valores absolutos para então entender as especificidades regionais. O bioma 

Mata Atlântica, aqui representado pela microrregião de Ubá, já é alvo da expansão da 

fronteira agrícola há algumas centenas de anos. 

Quando da intervenção portuguesa no início da colonização do território nacional, a 

Mata Atlântica já era alvo dos interesses comerciais, sua exuberante mata nativa ostentava um 

tesouro indispensável ao modelo extrativista proposto por Portugal, esse tesouro veio 

posteriormente a dar nome ao país, o Pau Brasil, espécie inocentemente responsável por 

grande parte da devastação ocasionada, a suas qualidades comerciais elevaram a cobiça 

humana a ultima instancia, promovendo um verdadeiro massacre da espécie. 

Isso posto é notável que a região de análise desse estudo não possui número 

expressivo de área com formação vegetal, portanto qualquer alteração nesse bioma deve ser 

medida não somente por seu valor absoluto e sim, relativizando esses fatos históricos.  

As Figuras de numero 5 a 10 apresentam os dados do desmatamento acumulado ano a 

ano com exceção dos anos 1998 e 2002, pois conforme já foi apresentado, para esses dois 

anos não foi encontrado imagens do satélite Landsat 5 com cobertura de nuvem mínima 

tolerável para a aplicação da metodologia. 

No entanto as alterações de supressão de mata nativa ocorrida nesses períodos foram 

englobadas nos mapeamentos de 1997 – 1999 e 2001 – 2003 respectivamente, visto que a 

análise é referente ao total acumulado. 

A Figura 11 demostra o acumulado de supressão de mata nativa para todo período 

estudado de 1996 até 2004, apresenta também os focos de alteração para especializar as 

ocorrências.
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Figura 5 – Desmatamento acumulado da Microrregião de Ubá 1996 – 1997. Fonte: Elaborado pelo autor 

 

Figura 6 – Desmatamento acumulado da Microrregião de Ubá 1997 – 1999. Fonte: Elaborado pelo autor 
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Figura 7 – Desmatamento acumulado da Microrregião de Ubá 1999 – 2000. Fonte: Elaborado pelo autor 

Fi

gura 8 – Desmatamento acumulado da Microrregião de Ubá 2000 – 2001. Fonte: Elaborado pelo autor 
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Figura 9 – Desmatamento acumulado da Microrregião de Ubá 2001 – 2003. Fonte: Elaborado pelo autor 

Fi

gura 10 – Desmatamento acumulado da Microrregião de Ubá 2003 – 2004. Fonte: Elaborado pelo autor 
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Figura 11 – Desmatamento acumulado da Microrregião de Ubá 1996 – 2004. Fonte: Elaborado pelo autor 
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Interessante observar que a intensidade do desmatamento na região foi diminuindo no 

período de 1996 para 2004, nesse ultimo ano foi observado apenas um foco de desmatamento 

esse na cidade de Mercês conforme a Figura 10. 

O período líder em desmatamento foi o ano 1997 – 1999, com um total de 143,62 

hectares de mata suprimida distribuídos em 40 focos, foi líder tanto no número de focos como 

em área total alterada. Os anos inicias de análise da pesquisa somaram 13 focos de 

desmatamento com um total alterado de 34,18 hectares. 

Os 15 focos detectados no período de 1999 até 2000 tiveram um total de supressão de 

35,51 hectares de mata. No ano seguinte 2000 até 2001 os 22,58 hectares de mata suprimida 

estão distribuídos em 12 focos, portanto a partir desse ano já nota-se uma redução na 

intensidade no desmatamento realidade sentida realmente nos anos seguintes onde entre 2001 

e 2003 apenas 5 focos foram detectados em um total alterado de 16,25 hectares. 

Essa redução pode ter como um plausível motivo os debates envoltos a lei que se 

construía no congresso a já referida lei nº 11.428, de 22 de dezembro de 2006 que dispõe 

sobre a utilização e proteção da vegetação nativa do Bioma Mata Atlântica. Possivelmente 

prevendo os danos financeiros aos que promovem corte ilegal de nativa, propostos por essa 

nova lei, os produtores repensaram seu modo de intervenção na natureza. 

Com os dados do desmatamento levantados resta confronto com os dados do Censo 

Agropecuário para então verificar a real correlação entre o numero de pessoas empregadas por 

estabelecimento agropecuário e desmatamento na região.  

 

5.2 Dados do censo agropecuário  

Os dados secundários advindos do Censo Agropecuário de 1996 e do Censo 

Agropecuário de 2006 foram os utilizados na pesquisa para apurar o numero de 

trabalhadores rurais empregados por estabelecimento agropecuário, e consequentemente a 

sua diferença entre esses dois anos. 

A Tabela 7 e a Figura 12 mostram um diagnóstico do campo na microrregião de 

Ubá levantado como base os dados do Censo Agropecuário de 1996 e 2006. 
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Municípios 

Total de 
estabelecimentos 

agropecuários (ano) 

Total de pessoal 
ocupado no campo 

(ano) 

Pessoal ocupado por 
estabelecimentos 

agropecuários (ano) 

1996 2006 1996 2006 1996 2006 

Astolfo Dutra 335 313 740 647 2,20 2,06 

Divinésia 265 297 1 243 766 4,69 2,57 

Dores do Turvo 454 419 1 760 1 024 3,87 2,44 

Guarani 417 281 1 384 834 3,31 2,96 

Guidoval 586 569 2 343 1 137 3,99 1,99 

Guiricema 1 594 1 435 5 561 2 799 3,48 1,95 

Mercês 693 970 2 405 2 796 3,47 2,88 

Piraúba 444 392 1 778 666 4,00 1,69 

Rio Pomba 456 464 1 719 1 307 3,76 2,81 

Rodeiro 172 234 587 372 3,41 1,58 

São Geraldo 393 625 1 381 1 547 3,51 2,47 

Senador Firmino 571 545 2 066 1 512 3,61 2,77 

Silveirânia 197 276 773 540 3,92 1,95 

Tabuleiro 213 287 929 651 4,36 2,26 

Tocantins 603 837 2 338 2 055 3,87 2,45 

Ubá 1 020 877 3 625 1 748 3,55 1,99 

Visconde do Rio Branco 761 956 2 996 2 350 3,93 2,45 

Total 9 174 9 777 33 628 22 751 3,66 2,32 
Tabela 7 - Situação da zona rural por município 1996 – 2006. Dados: IBGE 

 

 Uma realidade que poderia prejudicar a conta da diferença entre pessoal ocupado por 

estabelecimentos agropecuários dos anos 1996 e 2006 seria uma alteração significativa no 

número de estabelecimentos agropecuários, porém, apesar de o número de propriedades rurais 

se manterem basicamente estável, foi observado redução abrupta do número de trabalhadores 

rurais dedicados a cada imóvel rural, na media total essa redução foi de 36,51%. As 

porcentagens por município podem ser vista na Tabela 9 e Figura 11. 

Município Redução (%) Município Redução (%) 

Astolfo Dutra -6,42 Ubá -43,91 

Guarani -10,57 Guiricema -44,09 

Mercês -16,94 Divinésia -45,01 

Senador Firmino -23,32 Tabuleiro -47,99 

Rio Pomba -25,27 Guidoval -50,02 

São Geraldo -29,56 Silveirânia -50,13 

Tocantins -36,67 Rodeiro -53,41 

Dores do Turvo -36,95 Piraúba -57,57 

Visconde do Rio Branco -37,56 Microrregião de Ubá -36,51 

Tabela 9- Redução percentual do número de trabalhadores por propriedade rural entre 1996 e 2006. 
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Em todos os municípios do estudo foi observada uma redução do número de 

trabalhadores por estabelecimento agropecuário. O menor índice de evasão de trabalhadores 

rurais foi encontrado em Astolfo Dutra, cidade que agrupa a segunda maior área desmatada. 

Recebem destaque também os municípios de Guidoval, Silveirânia, Rodeiro, Piraúba, ambos 

com redução superior a 50%, importante ressaltar que esses também fazem parte do polo 

moveleiro de Ubá.  

A atração por empregos providos pelo setor moveleiro em Ubá certamente é 

inequívoco dentro da dinâmica no campo. O homem residente da zona rural pode se 

locomover para a cidade assumir um trabalho nessa indústria e retornar no final do dia, essa 

migração pendular esta cada dia mais presente nas formas de trabalho. 

No entanto esse trabalho se limitou a analisar a questão que envolve o numero de 

trabalhadores empregados por estabelecimento agropecuário e o desmatamento, independente 

do numero de pessoas residentes na zona rural, ou fatores ligados ao êxodo rural. 

O objetivo era entender se existe alguma correlação direta entre o desmatamento e a 

diminuição do numero de empregados por estabelecimento agropecuário. Para então entender 

se a alteração na área de utilidade agrícola da fazenda tem efeito no numero de empregados, 

ou se esse fator é irrelevante dentro da dinâmica que envolve as formas de trabalho dentro do 

meio rural. 
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Figura 11 – Variação percentual do Pessoal ocupado por estabelecimento agropecuário na Microrregião de Ubá de 1996 – 2006. Fonte: Elaborado pelo autor 
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A Figura 11 torna mais tangível e clara a percepção do quanto fragmentada e sem 

uniformidade é a distribuição da variação percentual do numero de trabalhadores rurais 

empregados por estabelecimento agropecuário dos anos 1996 - 2006 na microrregião de Ubá, 

munícipios concomitantes, com distinção na variação POEA. De uma forma mais superficial 

também não consegue se perceber uma relação direta entre o desmatamento e a evasão rural. 

Um cinturão no entorno de Ubá caracteriza uma região com redução acentuada no 

número de evasão rural, aproximadamente 44%. Numero bem superior à média da 

microrregião que foi de 36,51%, no entanto dentro desse mesmo entorno o desmatamento não 

seguiu um padrão tão linear, o município de Rodeiro, segundo maior responsável pela evasão 

rural da região com 53,41% de redução de trabalhadores por propriedade, não teve no 

desmatamento do período uma base nos processos agrícolas, em Rodeiro foi detectada apenas 

5,99 hectares de supressão. 

Astolfo Dutra, município de menor participação na evasão rural apenas 6,42% teve 

forte participação no processo de supressão de mata nativa para o período analisado, contanto 

com área total alterada de 38,31 hectares líder absoluto entre todos os municípios da 

microrregião. 

Uma correlação simplista entre esses dois municípios poderia levar a uma conclusão 

precipitada e equivocada de que o desmatamento foi causa fundamental para manutenção do 

homem no campo, visto que o município de menor evasão foi líder em desmate e o segundo 

líder em redução do POEA teve baixo percentual de desmate. 

Porem Guarani teve o segundo menor índice de variação POEA 10,57%, não 

comungou com seu vizinho Astolfo Dutra quanto à área desmatada, esse teve apenas 6,94 

hectares de supressão, logo para Guarani o desmate não foi fator relevante para fixação do 

trabalhador no campo. 

Guiricema, um dos mais elevados incides de evasão 44,09% responsável no entanto 

por um dos menores índices de desmate somando apenas 5,49 hectares ao longo dos 8 anos de 

observação.   

Municípios com alto índice de desmatamento apresentando baixa evasão de 

trabalhadores rurais, como é o caso de Astolfo Dutra e Mercês. Na outra ponta da análise, 

municípios como Rodeiro e Guidoval, classificados com grande índice de variação negativa 

POEA, teve percentual de desmatamento muito baixo para o período. 
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Essa descontinuidade dos dados já mostrava um possível quadro de inexistência de 

relação, visto que não foi observada em momento algum, uma linha que se mostrasse 

tendenciosa entre essas duas variáveis de redução do pessoal por estabelecimento e 

desmatamento. 

5.3 Regressão linear simples 

 Com todos os dados levantados e tabulados, coube uma apreciação mais aprofundada, 

para de fato verificar a existência de relação ou não entre o aumento da área de produção rural 

aqui representado pelo desmatamento, e a evasão do trabalhador do campo. 

Para essa conferência foi escolhido o método de regressão linear simples, comparando 

as variáveis por município de valor absoluto da diferença entre evasão rural por 

estabelecimento agropecuário entre 1996 – 2006 e total de área desmatada, a tabela 8 

apresenta esses dados.  

  Município 

Pessoal ocupado por 
estabelecimento 

agropecuário (ano) 

Diferença entre 
Pessoal ocupado por 

estabelecimentos 
agropecuários 
(1996-2006) 

Área total 
desmatada (Ha) 

1996 2006 

Astolfo Dutra 2,21 2,07 -0,14 38,31 

Divinésia 4,69 2,58 -2,11 11,28 

Dores do Turvo 3,88 2,44 -1,43 29,72 

Guarani 3,32 2,97 -0,35 6,94 

Guidoval 4,00 2,00 -2,00 1,15 

Guiricema 3,49 1,95 -1,54 5,49 

Mercês 3,47 2,88 -0,59 23,07 

Piraúba 4,00 1,70 -2,31 16,26 

Rio Pomba 3,77 2,82 -0,95 8,77 

Rodeiro 3,41 1,59 -1,82 5,99 

São Geraldo 3,51 2,48 -1,04 0,00 

Senador Firmino 3,62 2,77 -0,84 12,32 

Silveirânia 3,92 1,96 -1,97 24,73 

Tabuleiro 4,36 2,27 -2,09 16,35 

Tocantins 3,88 2,46 -1,42 5,09 

Ubá 3,55 1,99 -1,56 42,22 

Visconde do Rio Branco 3,94 2,46 -1,48 8,03 

Total 3,67 2,33 -1,34 255,71 

Tabela 8 - Diferença entre Pessoal ocupado por estabelecimentos agropecuários (1996-2006) 

Fonte: Dados IBGE / Autor 
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Aplicado o método estatístico para a série de dados Tabela 8, obteve se um índice de 

correlação de 2% extremamente baixo, pela conformação dos dados distribuídos no gráfico de 

tendências é notório o quão disperso esses dados estão da linha de tendência o que descarta 

qualquer relação entre os dados amostrados, para uma correlação significativa seria necessário 

no mínimo 95% de correlação. 

 

Figura 6 – Regressao linear simples 

Fonte: Elaborado pelo autor 

 

Um quadro esperado visto que os dados são muito dispersos e fluidos. Visivelmente 

sem um padrão que fosse possível delinear tendências. 

Mesmo que o desmatamento não tenha se mostrado causa fundamental para influir nos 

dados sociais de variação do numero POEA. Não é um contrassenso dizer que ainda assim o 

desmate também não trouxe benefícios para manutenção desse homem no meio rural. 

A expansão da fronteira agrícola não significou, por outro lado, um 

incremento da absorção de mão-de-obra. A razão de trabalhadores / área aberta, 

experimentou considerável declínio, passando de 7 trabalhadores por 100 ha de 

área aberta, em 1970, a 4 em 1985; o mesmo observa-se na relação entre 

trabalhadores e área de lavouras, que passou de 44,7 a 24,5 trabalhadores por 

100 ha no mesmo período (Alho & Martins, 1995, p. 34-35) 
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6 Conclusão 

A tabulação dos dados de diferença do número de trabalhadores por propriedade rural 

entre os anos de 1996 e 2006 foi conclusiva em apresentar a realidade de que a redução do 

numero de trabalhadores rurais empregados por estabelecimento rural ainda se mostrava 

fortemente presente na década de 1990 e meados da década seguinte. 

Conforme a Tabela 9 apesar da expressiva media de 36% de redução do número de 

trabalhadores por propriedade rural na microrregião de Ubá, quatro são os municípios líderes 

em evasão rural: Guidoval, Silveirânia, Rodeiro, Piraúba. Todos com redução superior a 50%. 

Importante ressaltar que desses quatro municípios, apenas Silveirânia apesar de estar envolta 

no cinturão, não faz oficialmente parte do polo moveleiro de Ubá. 

Quanto aos dados levantados de desmatamento, ao contrário da variação do POEA, 

esses não foram tão expressivos, em uma área de 3.593,648 km² distribuída em 17 municípios 

só foi observado um total de 255,71 hectares suprimidos de mata nativa, ou seja, 0,07% do 

total, isso em um período de oito anos 1996 – 2004, uma justificativa plausível para essa 

realidade é que a região já possui vasto uso rural consolidado, com baixo percentual de 

cobertura vegetal nativa.  

O objetivo do trabalho foi verificar se um único elemento, no caso a área desmatada 

por município teria influencia sobre a redução do numero de pessoas empregadas no campo 

na microrregião de Ubá. 

Conforme o processo estatístico utilizado de regressão linear simples, não existe 

qualquer correlação entre essas duas variáveis. O índice de correlação foi de pouco mais de 

2%, para que pudesse se validar uma reta com tendência, seria necessário no mínimo um 

índice de correlação igual ou superior a 95%, logo o valor apurado foi insignificante para 

qualquer afirmação se não a de que inexiste relação. 

No entanto isso não impede que essa hipótese seja verdadeira em outras regiões do 

país, para microrregião de Ubá no período de 1996 a 2006 o desmatamento não foi causa 

decisiva no processo do êxodo rural.  
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